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Basic Operations of Picture Control Utility 2

What You Can Do with Picture Control Utility 2

This section provides a brief introduction to what you can do with Picture Control Utility 2.

Basic Operations of the Picture Control Utility 2 Windows

This section provides an introduction to the basic windows and operations of Picture
Control Utility 2.



What You Can Do with Picture Control Utility 2

file:///C|/...240_%94[%95i%97p/01_MAC%20-%20%89%C1%8DH%8C%E3/EN/PCU2Help/pc002000.html[2018/06/29 18:06:44]

Home > Basic Operations of Picture Control Utility 2 > What You Can Do with Picture
Control Utility 2

What You Can Do with Picture Control Utility 2
With Picture Control Utility 2, which can be installed as a standalone application for easy
operation, you can perform the actions described below.

Changing and managing custom Picture Controls
Picture Controls adjusted using Picture Control Utility 2 can be saved as custom Picture
Controls. Once saved as files, custom Picture Controls can be shared with other computers or
people, or can be exported to memory cards and imported into computers. In addition,
custom Picture Controls adjusted on cameras can also be imported into Picture Control Utility
2.
Managing Picture Controls
Picture Controls enable you to create exactly the sort of RAW images (NEF, NRW) that you
want. Picture Control Utility 2 enables you to manage the Picture Controls.

The 4 types of Picture Controls described below are available.

Nikon Picture Controls

Nikon Picture Control is a set of preset Picture Controls providing optimal values of
brightness, contrast, and hue, etc., for balanced results.

The eight types of Nikon Picture Controls described below are available.
Auto
This Picture Control is based on [Standard], and it provides automatic adjustment of
the hue and tone.
Standard
Standard processing for a balanced effect.
Neutral
Minimal processing for a natural effect.
Vivid
Pictures are enhanced for a vivid photoprint effect.
Monochrome
Convert pictures to monochrome.
Portrait
Pictures are processed to enhance the color and texture of human skin. For the D3
series, D300 series and D700, this is an optional Picture Control.
Landscape
Pictures are enhanced with a sense of depth that enlivens a wide variety of landscapes.
For the D3 series, D300 series and D700, this is an optional Picture Control.
Flat
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This Picture Control retains a wide range of tones, from highlights to shadows.

Optional Picture Controls

The Picture Controls described below are available as optional Nikon Picture Controls.
D2XMODE1
This optional Picture Control creates colors similar to those created using [Color mode]
in [Mode I] of the Nikon D2X / D2XS digital camera. Natural portrait skin tone and rich
gradation will be reproduced without the need for processing.
D2XMODE2
This optional Picture Control creates colors similar to those created using [Color mode]
in [Mode II] of the Nikon D2X / D2XS digital camera. Textures are rich in color, and
suited for extensive processing and retouching.
D2XMODE3
This optional Picture Control creates colors similar to those created using [Color mode]
in [Mode III] of the Nikon D2X / D2XS digital camera. Suited for nature and landscape
images. Green of trees and blue skies are reproduced vividly without the need for
processing.

Set [Brightness] to [-1] in Picture Control Utility 2 to create brightness similar to
the Nikon D2X / D2XS digital camera.
Using [D2XMODE1], [D2XMODE2] or [D2XMODE3] does not guarantee
reproduction of colors identical to those created using [Mode I], [Mode II] or [Mode
III] of the Nikon D2X / D2XS digital camera.

Creative Picture Control

Creative Picture Control is available for the Z 7 or later models. Various types are
available, each consisting of a unique combination of hue, tone, saturation, and other
settings that achieve a particular effect in an image.

The following 20 types of Creative Picture Control are available:
Dream
Morning
Pop
Sunday
Somber
Dramatic
Silence
Bleached
Melancholic
Pure
Denim
Toy
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Sepia
Blue
Red
Pink
Charcoal
Graphite
Binary
Carbon

Custom Picture Controls

You can create your own Picture Controls based on a Nikon Picture Control, optional
Picture Control, or Creative Picture Control by using the Picture Control Utility 2
application or a compatible camera. Custom Picture Controls can be saved as setting files
and shared among compatible cameras and software.

Notes

Adjustment by Picture Controls may not be applied to the image if you open the image
with applications that are not compatible with the Picture Control system.
To import/export custom Picture Controls to/from a camera, the camera needs to be
equipped with the custom Picture Control creation function.
The following types of Nikon digital single-lens reflex camera are not compatible with
the Picture Control system:
D2 Series, D1 Series, D200, D100, D80, D70 Series, D60, D50 and D40 Series
COOLPIX Picture Control is not supported.

Notes on using optional Picture Controls

There are two types of optional Picture Controls: those for the software and those for
the camera.

Software-related optional Picture Controls
These optional Picture Controls are installed and ready to use when the software is
installed.
Camera-related optional Picture Controls
These optional Picture Controls can be downloaded for use via the Internet. They can
be used with the camera models listed below.

D2XMODE1 / D2XMODE2 / D2XMODE3:
D3, D3X, D300, and D700
Portrait / Landscape:
D3 series, D300 series, and D700
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Basic Operations of the Picture Control Utility 2
Windows

Using Palettes

In Picture Control Utility 2, open palettes to import and edit Picture Control files. You can
also change the width of the palettes or separate them and move them around freely.

Using Preview Images

The center of the Picture Control Utility 2 window is the preview image area. You can use
the preview operation tools to change how preview images are displayed.

Quitting Picture Control Utility 2

This section describes how to quit Picture Control Utility 2.
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Using Palettes
In Picture Control Utility 2, display palettes to perform operations such as importing Picture
Control files or adjusting images.
The palette on the left is the [Product]/[List: Picture Controls] palette, the one on the right is
the [Adjustments]/[Custom Curve]/[Histogram] palette, and the one at the bottom is the
[Share] palette.

Adjusting palette width

Separating palettes

Selecting the display style of the [List: Picture Controls] palette

Adjusting palette width
Drag the border between palettes to adjust the width of each palette.

Separating palettes
The [Adjustments], [Histogram], [Share], and [Custom Curve] palettes can each be displayed
as a separate floating window.

1. Click the  button in the upper right of the palette to display the menu, and
select [Undock].
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The palette is separated from the main window.

You can move the separated window to the desired position by dragging the title bar.

To dock the separated window in the main window again, click the  button in the right
of the title bar to display the menu, and click [Dock].

Selecting the display style of the [List: Picture Controls] palette
The display items in [List: Picture Controls] can be changed.

1. Click  at the upper right to select the desired item.

The display items change.

You can select between [Detail View], [Simple View], and [Customize Detail View...].

If you select [Customize Detail View...], the [Preferences] window is displayed, allowing
you to choose whether or not to display adjustment values or thumbnails. For details on
[Preferences], refer to "Preferences of Picture Control Utility 2".
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About the [Tutorial] dialog

The [Tutorial] dialog is displayed only when the Picture Control Utility 2 is launched for
the first time.

To quit [Tutorial], click the [Close] button.

To display the [Tutorial] dialog again, select [Tutorial] in the [Window] menu.
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Using Preview Images
About the preview image area

Applying adjustments

Displaying histograms

Changing display magnification

Displaying advanced functions for image preview

Changing the preview image

Adjusting preview

Rotating

Changing the view mode

About the preview image area
The center of the Picture Control Utility 2 window is the preview image area.
The preview image displayed by default varies depending on the product selected in the
[Product] list.
You can use the preview operation tools to change how preview images are displayed.

Applying adjustments
You can click [Reflect Changes] to choose whether or not the adjustments made to the Picture
Control are applied to the preview image.

Displaying histograms
Click  to display the histogram of the displayed image. Click  in the upper right of
Histogram to change the details that are displayed.
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RGB: Displays the histograms of all RGB channels.
R/G/B: Displays the [Histogram] of the selected R/G/B channel only.
Brightness: Displays the [Histogram] of the brightness distribution only.

About [Histogram]

"Histogram" is a curve chart showing the distribution of brightness in an image. The
horizontal axis shows image brightness, and the vertical axis shows the number of pixels.
For bright images, the peak of the curve is located toward the right side of the chart, and
for dark images, the peak of the curve is located toward the left side of the chart. If the
curve does not drop to the bottom before reaching the far right side of the chart, the
image has lost highlights. If it does not drop to the bottom before reaching the far left
side, the image has lost shadows.

Changing display magnification
Drag the slider horizontally to magnify/reduce the preview image.
Set the slider to  to display the full image in the preview image area.

Displaying advanced functions for image preview
Click [Preview] to display/hide advanced functions. By displaying advanced functions, you can
change, adjust, and rotate the preview image, and change the view mode.

Changing the preview image
Click [Change Image...] to change the image used for preview. Select the desired image via
the file selection dialog.
Only RAW images in NEF format captured on a Nikon digital single-lens reflex camera,
mirrorless camera, or COOLPIX A can be used as preview images.

RAW images are displayed with the currently selected Picture Control applied.
The exposure, white balance, and Active D-Lighting of a preview image is displayed with the
settings at the time of shooting.
Images that are edited using the Capture NX-D or ViewNX-i software after shooting are
displayed without the changes applied.

Notes

A confirmation dialog is displayed when the Picture Control of the product selected in
the [Product] list differs from that of the image that you want to display.
An image taken with a camera that does not support Picture Controls and custom
Picture Controls can be displayed as a preview image, but it cannot be used to create a
custom Picture Control.
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Adjusting preview
Click [Adjust Preview...] to adjust the preview image quality. Use the [Adjust Preview] window
to make adjustments.
For details, refer to "Editing Preview Images".
Adjustments made using the [Adjust Preview] window will not be applied to the custom Picture
Control that you are creating.

Rotating
Click  /  to rotate the displayed image in the corresponding direction 90 degrees.

Changing the view mode
Change the view mode of the preview window.

: Use the entire screen to display the enlarged preview image. To return to the original
window, click the  button or press the Esc key.

 / : Vertically or horizontally align the adjusted preview image along with the image
that uses the Picture Control selected in [Compare with] in the [Preview] menu.

: Return to single image display.
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Home > Basic Operations of Picture Control Utility 2 > Basic Operations of the Picture
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Quitting Picture Control Utility 2
You can quit Picture Control Utility 2. When you started Picture Control Utility 2 from another
Nikon application, Picture Control Utility 2 does not end, even if the other application is closed.

1. Click [Quit Picture Control Utility 2] in the [File] menu (or the [Picture Control
Utility 2] menu in Mac OS).

Picture Control Utility 2 ends. When Picture Control Utility 2 ends,  is removed from
Taskbar in Windows.
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Detailed Operations of Picture Control Utility 2

About Custom Picture Controls

Creating/Editing Custom Picture Control

This section describes the procedure for creating a custom Picture Control.

Importing Custom Picture Control

Import custom Picture Controls created on compatible cameras or software into Picture
Control Utility 2.

Exporting Custom Picture Control

Export created custom Picture Controls to files. They can be used on compatible cameras
or software.

Deleting Custom Picture Control

Delete custom Picture Controls registered in Picture Control Utility 2.

Changing the Names and Comments of Custom Picture Controls

Change the names and comments of custom Picture Controls registered in Picture Control
Utility 2.

Menu List of Picture Control Utility 2

This section lists the menu options available in Picture Control Utility 2.
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About Custom Picture Controls
Types and features of custom Picture Control files

Types and features of custom Picture Control files
The 3 types of custom Picture Control files are [NCP], [NP2], and [NP3]. The available types of
custom Picture Control files depend on the camera used for shooting.

NP3
You can use NP3 custom Picture Control files for the Z 7 or later models.

Features
Various types of [Creative Picture Control] are available, each consisting of a unique
combination of hue, tone, saturation, and other settings that achieve a particular effect in
an image.
The [Adjust Sharpness] setting is available. You can easily adjust sharpness by using
[Quick Sharp], or you can make detailed adjustments by using [Mid-range Sharpening].
The previous [Sharpening] adjustment range of "0 to 9" has been expanded to "-3 to 9",
enabling you to create images with edges ranging from soft to sharp.

NP2
You can use NP2 custom Picture Control files for the D810 or later models.

Features
The [Flat] and [Auto]* Picture Controls are available.
* The [Auto] Picture Control is available only for the D7500, D850, and other NP3
compatible cameras.
The [Clarity] setting is available.
Each setting can be adjusted in steps of 0.25, enabling more detailed adjustment than
that of NCP.
The previous [Brightness] adjustment range of "-1 to 1" has been expanded to "-1.5 to
1.5".

NCP
You can use NCP custom Picture Control files for all cameras that support custom Picture
Controls.
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Cameras compatible with custom Picture Controls

NP3, NP2, NCP: Z 7 or later models
NP2, NCP: Z 7 or later models, D5, D500, D850, D810/D810A, D750, D7500, D7200,
D5500/D5600
NCP: D3/D3X/D3S/D4/D4S, Df, D800/D800E, D700, D600/D610,
D300/D300S, D7000/D7100, D5000/D5100/D5200/D5300, D90, Nikon 1 series,
COOLPIX A

Software compatible with custom Picture Controls

Capture NX-D
ViewNX-i
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Creating/Editing Custom Picture Control
You can create a new custom Picture Control. To create a custom Picture Control, edit the
settings of a Nikon Picture Control, optional Picture Control, or Creative Picture Control, or edit
the settings of a custom Picture Control that has already been created.

For details on the types of custom Picture Controls and supported products, refer to "About
Custom Picture Controls".

Selecting the product to use

Selecting the Picture Control

Adjusting

Saving

Selecting the product to use

1. Select [Add product...] in [Product].

The [Add Product] window is displayed.

2. Select the camera or application to use in [Product Category:] and [Product:], and
click the [Add] button.
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The product is added to the [Product] list.

3. Click [OK].

The [Add Product]window is closed.

4. Select the product to use from the [Product] list.

About [Product]

When the product selected in the [Product] list is changed, a confirmation dialog may
be displayed.
If the Picture Control changes when the product selected in the [Product] list is
changed, the available adjustment items, adjustment range, and adjustment steps
corresponding to the changed Picture Control are applied.
You may not be able to select certain products in the [Product] list depending on the
Picture Control that is selected.

Selecting the Picture Control

1. In the [List: Picture Controls] list, select the Picture Control on which to base the
new custom Picture Control.
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You may not be able to select certain Picture Controls depending on the product that is
selected in the [Product] list.

Adjusting

1. Configure each item on the [Adjustments] palette.

For settings for the items, refer to"About Level Adjustment".

If you turn on the [Reflect Changes] button in the preview operation tools, the settings
will be applied instantly when you adjust them.
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Saving

1. Click [Add to List] or [Overwrite].

Use [Add to List] to save the newly configured settings to [List: Picture Controls] as a
new custom Picture Control. Use [Overwrite] to overwrite the base custom Picture
Control with the new settings.

Clicking [Add to List] will display the screen to name a new picture control. Follow to
Step 2.

Clicking [Overwrite] will display the confirmation screen for overwriting. The selected
custom picture control will be overwritten if you click [OK].

2. If you are creating a new custom Picture Control, enter a name and comment,
and click [OK].

Custom Picture Control names can be up to 19 English one-byte characters and symbols.

If [NCP] is selected in the [Product] list, you cannot input comments.
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The new custom Picture Control is created. It is added under Creative Picture Control on
the [List: Picture Controls] palette, in the order that it was created.

Available characters

Up to 256 single-byte or double-byte characters can be entered as a comment on a
custom Picture control.

A string of up to 19 single-byte characters can be entered as a custom Picture Control
name. The characters listed below are available.

Alphabet: A to Z (upper case or lower case)

Numbers: 0 to 9

Symbols: ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~ single space

Note

You cannot overwrite a Nikon Picture Control, optional Picture Control, or Creative
Picture Control. You can click [Overwrite] only when you have modified a custom Picture
Control.

[Flat] and [Auto] cannot be selected in [List: Picture Controls].

[Flat] and [Auto] cannot be selected when "(NCP)" is displayed next to the product
name in the [Product] list. They can be selected only for products with "(NP2)" or
"(NP3)" displayed next to the product name.

[Auto] can be selected only for camera models newer than the D7500.

Regarding [Auto]

The range of adjustment is from -2 to +2.
Adjustments are made in steps of 1.
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[Custom Curve] is not available.
This item may not be available, depending on the camera used for shooting.

Creative Picture Control cannot be selected in [List: Picture Controls]

You can use Creative Picture Control when [NP3] is selected in the [Product] list.
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Home > Detailed Operations of Picture Control Utility 2 > Creating/Editing Custom
Picture Control > About Level Adjustment

About Level Adjustment
To create a custom Picture Control, edit the settings of a Nikon Picture Control, optional Picture
Control, or Creative Picture Control, or edit the settings of a custom Picture Control that has
already been created.

If you turn on the [Reflect Changes] button in the preview operation tools, the settings will be
applied instantly when you adjust them.

Editing the Picture Controls

Settings for level adjustment

Settings related to saving and adding

Editing the Picture Controls

1. Select one of the Picture Controls listed in [List: Picture Controls].

You may not be able to select certain Picture Controls depending on the product that is
selected in the [Product] list.

2. Adjust the Picture Control with [Quick Adjust], [Effect Level], or [Adjust
Sharpness].
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The adjustment items and adjustment range displayed on the [Adjustments] palette
depend on the Picture Control that is selected.

1. When [NCP] or [NP2] is selected: [Quick Adjust]
2. When Creative Picture Control is selected: [Effect Level] and [Adjust Sharpness]
3. When [NP3] is selected: [Adjust Sharpness]

[Quick Adjust] adjusts contrast, brightness, saturation, hue, etc., for adequate and
balanced values of an image.

[Adjust Sharpness] adjusts sharpness in detail.

[Effect Level] mutes or heightens the effect of Creative Picture Control.

Checking [Auto] sets the most suitable value automatically.
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3. Select [Manual Adjustments] and drag the slider of each item horizontally to
make detailed adjustments.

Checking [Auto] sets the most suitable value automatically.

4. Use a tone curve to make a detailed adjustment of brightness or contrast.

The tone curve allows for adjustment of either or both input (original color of the image)
and output (color of the image that is finally produced).

For details on the settings of each item, refer to "Settings for level adjustment". For
details on tone curves, refer to "About Custom Curve".



About Level Adjustment

file:///C|/...240_%94[%95i%97p/01_MAC%20-%20%89%C1%8DH%8C%E3/EN/PCU2Help/pc009000.html[2018/06/29 18:06:51]

Note

When [Neutral], [Monochrome], [Flat], or a custom Picture Control is used as a base
Picture Control, [Quick Adjust] cannot be selected. Use [Manual Adjustments] for
adjustment.
[Custom Curve] is not available when the base Picture Control is [Auto].

Settings for level adjustment
The items described below may vary depending on the selected Picture Control.

The displayed setting items may vary. You cannot adjust items that are grayed out.
The display area, adjustment range, or adjustment steps may vary, even when the setting
items are the same.

□Quick Adjust
Use this item to adjust the level of each item automatically. Drag the slider horizontally to
adjust them. You can also enter a numeric value in the input box.

□Effect Level
Mute or heighten the effect of Creative Picture Control. Drag the slider to the left to
decrease the effect, and drag it to the right to increase the effect. You can also enter a
numeric value in the input box.

□Adjust Sharpness
Adjust the sharpness level manually.

[Quick Sharp]
Quickly adjust the levels for [Sharpening], [Mid-range Sharpening] and [Clarity]. Drag the
slider to the left to decrease the sharpness, and drag it to the right to increase the
sharpness. You can also enter a numeric value in the input box.

[Auto]
Automatically adjusts sharpness.

[Mid-range Sharpening]
Adjust mid-tones affected by [Sharpening] and [Clarity]. Drag the slider to the left to
decrease the sharpness, and drag it to the right to increase the sharpness. You can also
enter a numeric value in the input box.

□Manual Adjustments
Adjust the level of each item manually.
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[Sharpening]
Adjust the sharpening of the outline. If you drag the slider to the left, the image outline
blurs, and if you drag it to the right, it is sharpened. You can enter a numeric value in the
input box.

[Auto]
Automatically adjusts sharpening.

[Clarity]
Adjust the level of clarity. Drag the slider to the left to decrease the clarity, and drag it to
the right to increase the clarity. You can also enter a numeric value in the input box.

[Auto]
Automatically adjusts clarity.

[Contrast]
Adjust contrast. Adjust it by dragging the slider horizontally. You can also enter a numeric
value in the input box. This option cannot be selected when [Use Custom Curve] is
selected.

[Auto]
Automatically adjusts contrast.

[Brightness]
Adjust brightness. Adjust it by dragging the slider horizontally. You can also enter a
numeric value in the input box. This option cannot be selected when [Use Custom Curve]
is selected.

[Use Custom Curve]
Manually adjust saturation and hue. [Contrast] and [Brightness] cannot be selected when
this item is selected.

[Saturation]
Adjust saturation. Drag the slider horizontally to adjust it. You can also enter a numeric
value in the input box. This item cannot be selected when [Monochrome] is used as the
base Picture Control.

[Auto]
Automatically adjusts saturation.

[Hue]
Adjust hue. Drag the slider horizontally to adjust it. You can also enter a numeric value in
the input box. This item cannot be selected when [Monochrome] is used as the base



About Level Adjustment

file:///C|/...240_%94[%95i%97p/01_MAC%20-%20%89%C1%8DH%8C%E3/EN/PCU2Help/pc009000.html[2018/06/29 18:06:51]

Picture Control.

[Filter Effects]
Enabled only when [Monochrome] is selected for the Nikon Picture Control. Click  to
select filter effect.

Items selectable for Filter Effect

Off
Yellow
Orange
Red
Green

[Toning]/[Adjust Saturation]/[Toning]
Enabled only when [Monochrome] is selected for the Nikon Picture Control. Click  to
select the tint, and drag the slider horizontally to adjust saturation. Saturation control is
not available when [B&W] is selected. You can also enter a numeric value in the input box.
[Toning] is available when certain types of Creative Picture Control are selected.

Items selectable for Toning

B&W
Sepia
Cyanotype
Red
Yellow
Green
Blue Green
Blue
Purple Blue
Red Purple

Types of Creative Picture Control for which [Toning] can be adjusted

Sepia
Blue
Red
Pink

□Custom Curve
When the [Use Custom Curve] is selected, adjust brightness and contrast using tone
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curve. For details of the custom curve, refer to "About Custom Curve".

(Tone Curve)
Adjust brightness and contrast by dragging an anchor point on the tone curve. Up to 20
anchor points can be added. To add an anchor point, drag the line to any point. To delete
an anchor point, drag it outside [Custom Curve] or press the "Delete" key. For details on
tone curves, refer to "About Custom Curve".

Memo

If you edit the tone curve, the displayed histogram may have vertical lines. This is a
phenomenon caused by quick display of the edited results. This kind of tone skipping
phenomenon does not necessarily occur in the actual image.

Automatically adjusts contrast.

Changes the cursor to the dropper tool. If you click the black point of the image, you can
adjust the tone.

Changes the cursor to the dropper tool. If you click the white point of the image, you can
adjust the tone.

Resets the tone curve.

Displays the adjusted histogram. Another clicking displays the pre-adjustment histogram.

Loads an existing custom tone curve to Picture Control Utility 2. Files with the .ntc, .ncv, or
.set extension can be loaded.

Saves the created custom tone curve to Picture Control Utility 2. The file is saved with the
.ntc extension.
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File extensions appended to custom tone curves

.ntc: Custom tone curve created using Camera Control Pro 2 or Picture Control
Utility 2
.ncv: Custom tone curve created using Nikon Capture
.set: Custom tone curve created using Capture NX or Capture NX 2

Settings related to saving and adding

[Reset]
When a Nikon Picture Control, optional Picture Control, or Creative Picture Control is
selected, all items are reset to their default settings. When a custom Picture Control is
selected, all items are reset to their previous values before adjustment.

[Add to List]
Registers the adjusted Picture Control with a new name. The registered Picture Control is
added to the Picture Control list.

[Overwrite]
Overwrites the current Picture Control with the settings that you adjusted. You cannot
select [Overwrite] when the adjusted settings are based on a Nikon Picture Control,
optional Picture Control, or Creative Picture Control.
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Home > Detailed Operations of Picture Control Utility 2 > Creating/Editing Custom
Picture Control > About Custom Curve

About Custom Curve
Outline of tone curve

White and black points

Outline of tone curve

[Custom Curve] is a tone curve that shows the relationships between input (original image
colors) and output (how the original image colors are reproduced in the final image). The
default tone curve is set to a straight line. This means that the image is output with the
original colors that were input.

The input image colors are placed on the horizontal axis. The shadow (dark part of an image)
is reflected on the left; the highlight (bright part of an image) on the right; and the halftone in
the center. On the horizontal axis, the leftmost end indicates the minimum value (0) and the
rightmost end indicates the maximum value (255). The minimum value indicates the area of
an input image that is completely black, and the maximum value indicates the area of an input
image that is completely white.
The output image colors are placed on the vertical axis. The allowable minimum value (0) to be
output is placed at the bottom, and the allowable maximum value (255)to be output at the
top.

1. Shadow
2. Highlight
3. Input black point
4. Input white point
5. Output white point
6. Tone curve
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7. Output black point

[Custom Curve] is represented by an input value between 0 and 255; however, it is actually
obtained at 16-bit accuracy, resulting in 255 being processed as 65535. This enables you to
sufficiently maintain the image quality of 12-bit RAW images.

White and black points

Input level

Output level

Tone curve

Gamma correction

The four corners of the tone curve are referred to as white and black points. The black point of
an image indicates the darkest color tone (minimum value), and the white point indicates the
brightest color tone (maximum value). The default black point for both the input and output
values is set to 0. The darkest color tone value of the actual input image (original image) may
be greater than 0. Changing the input value of a black point to the darkest color tone of the
actual image will generate a steep inclination of a tone curve, resulting in enhanced contrast of
the entire image without reducing the shadow accuracy. If the original image does not actually
contain the color tone equivalent to the maximum value, reduce the white point value in order
to adjust it to the brightest color tone of the actual image.

To obtain a desired effect, specify the white point and black point levels on the input
(horizontal axis), and change those levels on the output (vertical axis) to fit the actual contrast
between the brightest and darkest parts of the image. If the darkest color tone of the image is
actually brighter than solid black, raise the output level of the black point to obtain a natural
color tone.

Input level

The following methods are available for adjusting the input levels of the white and black points.

Automatic contrast adjustment

1. Click .
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The white and black points are specified automatically. The brightest part on an image is
then set to white and the darkest part to black. Redistribute the tone, and adjust the
contrast of the entire image.

Adjusting the white and black points with sliders

1. Drag the horizontal axis slider horizontally.

This slider is used to adjust the white and black points to a histogram.
Drag the white point input slider  and the black point input slider  horizontally.
Setting the black point input slider  to the lowest input value shown in the

histogram will result in the minimum output value that matches the tone of the darkest
part of the image. This will generate a steep inclination of a tone curve, resulting in
enhanced contrast without damaging the shadow details.

In the same way, setting the white point input slider  to the highest input value
shown in the histogram will result in the maximum output value that matches the tone
of the brightest part of the image. This will enhance the contrast without damaging
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highlight details.

Image sampling with dropper tool

1. Click  to specify the white point of an image or click  to specify the black
point of an image.

To specify the white and black points, you can also use the actual image for
sampling. This function is useful because it enables you to select the darkest part
within the details of the image and to specify the value of the black point. This enables
you to eliminate unnecessary details that are darker than the specified black point
value in the final image. It also enables you to select the brightest part of important
details in the final image and match it to the value of the white point.

To specify a white point, click , check that the cursor has changed into the
dropper tool, and click on the brightest part of the image.

In the same way, to specify a black point, click , check that the cursor has
changed into the dropper tool, and click on the darkest part of the image.

Output level

Drag the white point output slider  and black point output slider  vertically to specify
the white point and black point output levels.
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Tone curve

The tone curve shows the curve relationship between input (original image colors) and output
(how the original image colors are reproduced in the final image). Editing the tone curve
enables you to adjust the input and output values. The default tone curve is set to a straight
line. This means that the image is output with the original colors that were input.

Reshaping the tone curve changes the relationships between the input and output, enabling
you to finely adjust the brightness and contrast in a specific tonal range. For example, setting a
steep inclination of the tone curve in a specific tonal range will increase the accuracy of the
relevant part to be enhanced. Also, changing the tone curve to set the output value to be
higher than the input value in a specific tonal range will result in a brighter tone. Also, changing
the tone curve to set the input value to a lower output value will result in a darker tone.

Add a new anchor point

1. Drag any position of the line and add an anchor point.

Up to 20 anchor points can be added. The added anchor points can be moved again by
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dragging them.

Delete an anchor point

1. Click the anchor point to delete, and drag it outside the tone curve.

You can also use the "Delete" key to delete an anchor point.

Reset a tone curve

1. Click .

The tone curve is reset and returns to the default straight line.

Gamma correction

Drag the slider horizontally to change the gamma value. Dragging it to the left makes the
halftone of the image brighter and dragging to the right makes the halftone darker.
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Home > Detailed Operations of Picture Control Utility 2 > Creating/Editing Custom
Picture Control > Editing Preview Images

Editing Preview Images
You can adjust the exposure, white balance, and Active D-Lighting setting on the preview
image.

Displaying the [Adjust Preview] window

Adjusting exposure compensation

Adjusting white balance

Adjusting Active D-Lighting

Displaying the [Adjust Preview] window

1. Click [Preview].

2. Click [Adjust Preview...].
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The [Adjust Preview] window is displayed.

Adjustments made using the [Adjust Preview] window will not be applied to the custom
Picture Control that you are creating.

Adjusting exposure compensation

You can adjust the exposure compensation.

1. Drag the [Exposure Compensation] slider to specify the value.
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The exposure of the image is adjusted.

The allowable range of exposure compensation level is -5.0EV to +5.0EV, in 0.01EV
steps.

You can also specify the value by entering a numeric value (down to the second decimal
place) in the input box.

Adjusting white balance
You can adjust the white balance of an image.

1. Click  of [White Balance], and select the desired item.

The white balance is adjusted based on the selected item.

2. Drag the [Fine Adjustment] or [Tint] slider to specify the fine adjustment values.
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White Balance is adjusted based on the specified values.

Drag the [Fine Adjustment] slider to adjust the color temperature. The available
values vary depending on the selected white balance.

To adjust tint, drag the [Tint] slider. You can set a value from -12 to 12. Setting a
positive value makes magenta lighter (green deeper), and setting a negative value
makes green lighter (magenta deeper).

You can also specify the value by entering a numeric value in the input box.

Items selectable for White Balance and values for Color Temperature

Recorded Value
White balance is set to the value recorded.
Calculate Automatically
White balance is adjusted automatically based on the RAW image with Picture Control
Utility 2.

When adjusting color temperature using [Fine Adjustment], the default value and
the available range are automatically set.

Auto0
Tone is automatically adjusted with an emphasis on white color expression.
This item may not be available, depending on the camera used for shooting.
Auto1
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Suited to most shooting situations.
This item may not be available, depending on the camera used for shooting.
Auto2
Picture Control Utility 2 automatically adjusts the color tone to keep the warmth of the
light bulb color, based on the RAW image taken under incandescent lighting.
This item may not be available, depending on the camera used for shooting.
Natural Light Auto
Optimizes white balance for natural light, including sunlight, cloud, and shade.
This item may not be available, depending on the camera used for shooting.
Incandescent
Suited to photos taken under incandescent lighting.
Color temperature: 3000K
Available color temperature range: 2610K - 3533K
Standard Fluorescent
Suited to standard fluorescent lighting.
Color temperature: 4200K
Available color temperature range: 3472K - 5319K
High Color Rendering Fluorescent
Suited to high color rendering fluorescent lighting.
Color temperature: 4200K
Available color temperature range: 3472K - 5319K
Direct Sunlight
Suited to images taken in direct sun light.
Color temperature: 5200K
Available color temperature range: 2500K - 7042K
Shade
Suited to images taken in the shade on sunny days.
Color temperature: 8000K
Available color temperature range: 5714K - 9090K
Cloudy
Suited to images taken under overcast skies.
Color temperature: 6000K
Available color temperature range: 4629K - 8620K
Flash
Suited to images taken with Nikon Speedlights.
Color temperature: 5400K
Available color temperature range: 4255K - 7407K
FL-G1
Suited to images taken using a Nikon Speedlight with a filter for fluorescent light (FL-
G1, SZ-3FL) attached.
Color temperature: 5464K
Available color temperature range: 4301K - 7553K
FL-G2
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Suited to images taken using a Nikon Speedlight with a filter for fluorescent light (FL-
G2) attached.
Color temperature: 5988K
Available color temperature range: 4610K - 8562K
TN-A1
Suited to images taken using a Nikon Speedlight with a filter for incandescent/tungsten
light (TN-A1, SZ-3TN) attached.
Color temperature: 2445K
Available color temperature range: 2180K - 2789K
TN-A2
Suited to images taken using a Nikon Speedlight with a filter for incandescent/tungsten
light (TN-A2) attached.
Color temperature: 5000K
Available color temperature range: 4000K - 6622K
Underwater
Suited to images taken underwater.
[Underwater] is available only for RAW images taken with cameras that support
[Underwater].

Adjusting Active D-Lighting
You can adjust the Active D-Lighting setting.

1. Click  of [Active D-Lighting] to select the desired setting.
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Active D-Lighting is adjusted based on the selected setting.

If you do not want to apply the [Active D-Lighting] setting, select [OFF].

Notes

You may not be able to apply the Active D-Lighting setting, depending on the camera
used for shooting.
The [Active D-Lighting] settings that are available depend on the combination of the
product selected in the [Product] list or the selected Picture Control, and the camera
that was used for shooting the preview image.
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Home > Detailed Operations of Picture Control Utility 2 > Importing Custom Picture
Control

Importing Custom Picture Control
You can import custom Picture Controls created in compatible cameras or software to Picture
Control Utility 2.

Importing from a file

Importing from a memory card

Importing from a file

1. Click  at the bottom of the [List: Picture Controls] palette.

The file selection window is displayed.

You can also display the file selection window by going to the [File] menu and selecting
[Import Custom Picture Control], then[From File...].

2. Select the Picture Control to import, and click [Open].

The Picture Control is imported.

You can also import Picture Controls by clicking a Picture Control file or dragging and
dropping it onto the [List: Picture Controls] palette.
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Importing from a memory card

1. Click  at the bottom of the [List: Picture Controls] palette.

The Picture Control selection window is displayed.

You can also display the Picture Control selection window by going to the [File] menu
and selecting [Import Custom Picture Control], then [From Memory Card...].

2. Select custom Picture Controls to be imported, and click [OK].

You can select multiple custom Picture Controls at a time. The selected custom Picture
Controls are imported and displayed in the [List: Picture Controls] list.

When multiple memory cards are connected

If more than one memory card is used, a screen for selecting the desired source
(memory card) appears. Select a memory card containing custom Picture Controls to be
imported, and click [OK].

Notes

When a camera is connected, only the custom Picture Controls that are compatible
with the connected camera are displayed.
Memory cards used for importing or exporting custom Picture Controls should be
formatted in a compatible camera in advance.
Use a memory card reader, or select the [Mass Storage] for [USB] option in your
camera and then connect it to your PC.
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Picture Control Utility 2 can store up to 150 Picture Controls including optional Picture
Controls and custom Picture Controls.

Notes on custom Picture Controls created based on an optional Picture Control

To import and use a Picture Control, the optional Picture Control that was used to
create it needs to be installed in Picture Control Utility 2. For details on
downloading/installing optional Picture Controls, refer to the instructions on the
homepage.

Custom Picture Controls that were created based on an optional Picture Control are
not displayed in [List: Picture Controls] in the following cases:

When a camera or application with "(NP2)" or "(NP3)" displayed next to the
product name is selected in the [Product] list
When [D2XMODE1], [D2XMODE2], [D2XMODE3], or custom Picture Controls
created based on them are imported from a camera

In this case, select a camera or application that supports D2XMODE and check
[Preferences] in [D2XMODE] to display them in [List: Picture Controls].

You can use [D2XMODE1], [D2XMODE2], [D2XMODE3], and custom Picture Controls
created based on them only on a camera that supports D2XMODE (D3, D3X, D300,
and D700).
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Home > Detailed Operations of Picture Control Utility 2 > Exporting Custom Picture
Control

Exporting Custom Picture Control
You can export custom Picture Controls that you create to files for use in compatible cameras
or software.

Use in Software

Save to File

Save to Card

Use in Software

1. Select the custom Picture Control to export, and click [Use in Software] on the
[Share] palette.

Nikon applications installed on your computer are displayed. Select the desired
application to launch it.

Save to File

1. Select the custom Picture Control to export, and click [Save to File] on the
[Share] palette.



Exporting Custom Picture Control

file:///C|/...240_%94[%95i%97p/01_MAC%20-%20%89%C1%8DH%8C%E3/EN/PCU2Help/pc013000.html[2018/06/29 18:06:55]

The export destination selection window is displayed.

You can also display the export destination selection window by going to the [File] menu
and selecting [Export Custom Picture Control], then [To File...].

Save to:
Select the export destination folder. Click  to display the folder selection window.

File Name:
Change the file name. When multiple custom Picture Controls are selected, names
are automatically assigned and cannot be changed.

Comment:
Enter comments.
If [NCP] is selected in the [Product] list, you cannot input comments.

Save to Card

1. Select a custom Picture Control to export, and click [Save to Card] on the [Share]
palette.
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The custom Picture Control is saved to the memory card.

You can also save a custom Picture Control to a memory card by going to the [File]
menu and selecting [Export Custom Picture Control], then [To Memory Card...].

When multiple memory cards are connected

If more than one memory card is used, a screen for selecting the desired destination
(memory card) appears. Select a memory card to be exported, and click [OK].

Notes

Memory cards used for importing or exporting custom Picture Controls should be
formatted in a compatible camera in advance.

Use a memory card reader, or select the [Mass Storage] for [USB] option in your
camera and then connect it to your PC.

You can save 297 Picture Controls (up to 99 each for NCP, NP2, and NP3) on one
memory card.

About custom Picture Controls created based on an optional Picture Control:

The base optional Picture Controls also must be installed in the cameras or software of
the export destination to use it there. For details on the download and installation of
optional Picture Controls, refer to the instructions on the homepage.
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Home > Detailed Operations of Picture Control Utility 2 > Deleting Custom Picture
Control

Deleting Custom Picture Control
You can delete custom Picture Controls stored in your Picture Control Utility 2.

1. Select the custom Picture Control to delete, and click  at the bottom of the
[List: Picture Controls] palette.

The selected custom Picture Control is deleted.

You can also delete the desired Picture Control by right-clicking it (or clicking it while
holding down the Control key in Mac OS) on the [List: Picture Controls] palette and
selecting [Delete].

Note

You cannot delete a Nikon Picture Control, optional Picture Control, or Creative Picture
Control from the list of Picture Controls.
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Home > Detailed Operations of Picture Control Utility 2 > Changing the Names and
Comments of Custom Picture Controls

Changing the Names and Comments of Custom
Picture Controls
You can change the names and comments of custom Picture Controls stored in Picture Control
Utility 2.

1. Select a custom Picture Control to edit, and click the name or comment field.

The name or comment becomes editable.

You can also edit the name or comment of the desired Picture Control by right-clicking it
(or clicking it while holding down the Control key in Mac OS) and selecting [Rename]or
[Edit Comment].

2. Enter a name or comment, and click outside the name or comment field.

The name or comment of the custom Picture Control changes.

If [NCP] is selected in the [Product] list, you cannot input comments.

Available characters

Up to 256 single-byte or double-byte characters can be entered as a comment on a
custom Picture control.

A string of up to 19 single-byte characters can be entered as a custom Picture Control
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name. The characters listed below are available.

Alphabet: A to Z (upper case or lower case)

Numbers: 0 to 9

Symbols: ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~ single space

Note

You cannot rename a Nikon Picture Control, optional Picture Control, or Creative Picture
Control.
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Home > Detailed Operations of Picture Control Utility 2 > Preferences of Picture
Control Utility 2

Preferences of Picture Control Utility 2
Preferences

Setting items

Preferences

1. Select [Preferences...] in the [Edit] menu (or [Preferences...] in the [Picture
Control Utility 2] menu in Mac OS).

The [Preferences] window is displayed.

2. Select the item to change, and configure the setting.
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3. Click [OK].

The setting is applied.

Setting items
The settings listed below are available in the [Preferences] window.

□Customize Detail View
Set the items that are displayed when [Detail View] is selected for the Picture Control list.

Display setting values
Check [Display setting values] to display the setting values of [Sharpening], [Mid-range
Sharpening], [Clarity], [Contrast], [Brightness], [Saturation], [Hue], and [Filter Effects]
for a custom Picture Control, and to display whether the tone curve is used.
The types of adjustment values that are displayed depend on the product selected in the
[Product] list.

Display preview thumbnails
Check [Display preview thumbnails] to display the default image in the preview area of
Creative Picture Control, and to display the thumbnail with the applied adjustments in the
preview area of a custom Picture Control.

□Dialog Windows
Display the window that was previously set to not to be shown again.

Reset the "Don't show this dialog again" setting
Click [Reset] to disable the "Don't show this dialog again" setting.

□D2XMODE
Set whether to display optional Picture Controls (D2XMODE) and custom Picture Controls
created based on an optional Picture Control in [List: Picture Controls].
Check [D2XMODE] to display optional Picture Controls ([D2XMODE1]/ [D2XMODE2]/
[D2XMODE3]) and custom Picture Controls created based on D2XMODE.
These Picture Controls are available only for cameras that support D2XMODE (D3, D3X,
D300, D700).
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Home > Detailed Operations of Picture Control Utility 2 > Menu List of Picture Control
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Menu List of Picture Control Utility 2
The available menu list of Picture Control Utility 2.

[File] menu

[Edit] menu

[Preview] menu

[Window] menu

[Help] menu

[Picture Control Utility 2] menu (Mac OS only)

[File] menu

[Add Custom Picture Control to List...]
Assigns the created custom Picture Control a name and adds it to the Picture Control list.

Ctrl+N (Windows) / Command+N (Mac OS)
Creating/Editing Custom Picture Control

[Overwrite Custom Picture Control]
Overwrites the custom Picture Control in the Picture Control list with the one that you
created.

Ctrl+S (Windows) / Command+S (Mac OS)
Creating/Editing Custom Picture Control

[Rename Custom Picture Control]
Renames Picture Controls.

F2
Changing the Names and Comments of Custom Picture Controls

[Import Custom Picture Control]
Imports Picture Controls into the Picture Control list.

Importing Custom Picture Control

[Export Custom Picture Control]
Saves the created custom Picture Control.

Exporting Custom Picture Control

[Launch Capture NX-D]
Launches Capture NX-D. This item is displayed only when Capture NX-D is installed.

[Launch ViewNX-i]
Launches ViewNX-i. This item is displayed only when ViewNX-i is installed.
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[Quit Picture Control Utility 2] (Windows only)
Exits from Picture Control Utility 2.

Ctrl+Q(Windows)
Quitting Picture Control Utility 2

[Edit] menu

[Cut] (Mac OS only)
This function cuts the text being edited.

Command + X (Mac OS)

[Copy] (Mac OS only)
Copies selected text when editing text.

Command + C (Mac OS)

[Paste] (Mac OS only)
Copies selected text when editing text.

Command + V (Mac OS)

[Delete]
Delete custom Picture Controls registered in Picture Control Utility 2.

Delete

[Select All] (Mac OS only)
Selects all files.

Command + A (Mac OS)

[Reset Adjustments]
Restores all setting items to their previous values before adjustment.

About Level Adjustment

[Add Product...]
Displays the [Add product...] window.

Creating/Editing Custom Picture Control

[Preferences...] (Windows only)
Displays the [Preferences] window.

Ctrl+K (Windows)
Preferences of Picture Control Utility 2

[Preview] menu

[Change Preview Image...]
Changes the RAW image (NEF) used as the preview image.

Preferences of Picture Control Utility 2
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[Use Default Sample]
Restores the default preview image.

[Rotate 90°CW]
Rotates the preview image clockwise 90 degrees.

Ctrl+R (Windows) / Command+R (Mac OS)

[Rotate 90°CCW]
Rotates the preview image counterclockwise 90 degrees.

Ctrl+Shift+R (Windows) / Command+Shift+R (Mac OS)

[Rotate 180°]
Rotates the preview image 180 degrees.

[Full Screen]
Displays the preview image in full screen.

Ctrl+F (Windows) / Command+F (Mac OS)

[Single Preview]
Displays a single preview image in the preview image area.

[Compare Before/After Horizontally]
Aligns images horizontally.

[Compare Before/After Vertically]
Aligns images vertically.

[Compare with]
Select the Picture Controls to compare when [Compare Before/After Horizontally] or
[Compare Before/After Vertically] is selected.

[Zoom]
Changes the display magnification for the preview image.

[Window] menu

[Histogram]
Displays the histogram of the preview image.

Using Palettes

[Share]
Displays the [Share] palette.

Using Palettes

[Reset Layout]
Restores the default palette layout and sizes.
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[Tutorial]
Displays the [Tutorial] window.

[Help] menu

[Picture Control Utility 2 Help]
Displays this Help.

F1 (Windows)

[Check for Updates...]
Checks for updates.

[About Picture Control Utility 2] (Windows only)
Displays the Picture Control Utility 2 version information window.

[Picture Control Utility 2] menu (Mac OS only)

[About Picture Control Utility 2]
Display the Picture Control Utility 2 version information window. Click anywhere on the
screen to close the window.

[Preferences...]
Displays the [Preferences] window.

Command+, (Mac OS)
Preferences of Picture Control Utility 2

[Hide Picture Control Utility 2]
Hides Picture Control Utility 2.

[Hide Others]
Hides applications other than Picture Control Utility 2.

[Show All]
Shows all running applications.

[Quit Picture Control Utility 2]
Exits from Picture Control Utility 2.

Command+Q (Mac OS)
Quitting Picture Control Utility 2
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